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Learning resources
For all users of RootsMagic 7, there are plenty of resources available for learning and training. These are
some of those resources.
Roots Magic.com/learn/ OR when in RootsMagic, on the Main Menu go to “Learn”
Webinars (online classes), RootsMagic TV, Magic Guides (handouts), FamilySearch Family Tree Interface,
PAF Upgrade to RootsMagic, FTM Upgrade to RootsMagic

Getting the most out of RootsMagic 7
The book is very well written. It will give you step by step instructions with excellent illustrations
“Help” – on the main menu drop-down - “Contents” – put in a search term and it will bring up easy to
follow, step-by step instructions
Come to the Mesa FamilySearch Library for classes and one-on-one assistance

More help!
In addition to written materials and digital demonstrations, you can join a User Group, keep up
on changes (current and future) through the Blog, as well as the News. If you still need
assistance, you can call for Technical Support and Diane or Terri assist you.
RootsMagic User Group on Facebook – connects you with over 8000 users as well as staff to ask
questions, share ideas, and discuss how to use the software.
Blog, RootsMagic News, and more
Contact Technical Support
- Online Technical Support (general questions)
- Phone Support - 1-801-489-3102

Initial set-up of your database preferences
At any time, whether beginning or well into the use of RootsMagic, you can go to “Tools” and in
the drop-down select “File Options” and then “Program Options” and set your preferences for
the look and use of the database tools.
TOOLS – one of the first “go to” tabs in the Main Menu
File Options – for initial set-up of your database
Program Options – to change the display color and font

File Options – general set-up
The “General” tab will allow you to set a root person, determine the starting view when opening the
database, how to configure any nicknames, selecting a display number that will be listed after each
name, the date format (which can be set as the standardized date form found in FamilySearch) and LDS
Support and problem alerts.

File Options - Preparer
In the “Preparer” tab on the side bar, enter your contact information. It will then be included in any
printed materials you produce from the data base – like Pedigree Charts or Family Group Sheets.

File options - WebHints
Under “WebHints” you can enable each of the “partner” accounts which will bring hints from their
respective sites in the form of “lightbulbs” for individuals in your database. These hints are invaluable
and will speed your research efforts along.

Program options - DISPLAY
In the “Tools” drop-down at the bottom of the list is “Program Options”. This is where you can
customize the look of your database – changing Display color and Font style and size.
If you want purple and a more gothic font – you can have it….if you want green – with a bolded, all-cap
font…

Bells and whistles
Let’s look at some of the “Bells & Whistles” – beginning with the Tools tab in the main menu. The first
six we will consider are:
Merge
Problem Search
(a great list for potential research)
Count Trees
(clean up duplicates floating in your database)
Spell Check
Gazetteer
Mapping

MERGE
Manual Merge keeps you in the driver’s seat
Manual Merge – Brings up the side by side Merge Duplicate Records dialog for you to hand select the
duplicate people and merge them. Select the primary person on the left side (if different than the one
displayed), and the duplicate person on the right side.

MANUAL MERGE
You select the duplicate from your Index, compare the two and merge duplicate into primary.

Merged file
Once you have made the merge, if there is a difference between the two, you will see both names. You
can then delete the unwanted duplicate in the Edit Person screen

Problem search
In the Problem Search you have options of problems you are looking for in your database. These are the
default selections but they can be deselected or the age ranges can be adjusted.

Problem Search List
Problem Search list will bring up problems the program recognizes from the Selected Type of Problem.
You can edit directly from this List – a person or family problem, select “Not a problem”, add it to the
To-Do list, or Print. So if someone’s age is too old or a mother is too young, you can go directly to that
person and make a correction. If the person actually was 75 years old when married, just select Not a
Problem and the item drops off the Problem List and the problem icon disappears.

Count trees
Believe it or not, you probably have multiple “trees” in your database. These would represent people
who are in the database but not correctly connected to the main tree. You can see in the list who the
starting person is for each tree and the number of people in that tree. This function allows you to do a
little extra research to see who these individuals are, how they connect, and then get them properly
connected or removed from your database.

When counting trees you find how many unconnected “people and trees” you have in your data base
and this gives you the opportunity to research them and get them properly “connected”
A list of the trees will be displayed, along with the starting person for each tree and the number of
people in each tree.
You can highlight any tree in the list and click the "Go to tree" button to bring that tree up in the main
view.
You can highlight any tree in the list and click the "Print" button to print the list of trees.

Counting trees
Roger Ellis David is the first person in this tree of 31,708 people. Michael McHenry is the first
person in a tree of 2 people. Someone needs to be linked and fit back into the main tree!

Data Clean
DataClean is a tool that helps you to “clean up” your database. There are two functions – one is
NameClean, the other, PlaceClean. Through Data Clean you can have names and places with
problems and inconsistencies identified and corrected.

Name Clean
Name Clean allows you to identify problems connected with entry of names in the database.
NameClean offers a number of options for which type of problems to look for, e.g.:
Names in all uppercase
Improper spacing, capitalization, punctuation
Descriptions instead of names
Abbreviations, misplaced nicknames, or misplaced suffixes
Wife share husband’s surname

Place clean
Place Clean allows the same kind of opportunity to identify and correct various issues with the
entry of places into the database.

PlaceClean offers a number of options for which type of problemsto look for:
Names in all uppercase
Improper spacing or capitalization
Blank pieces
Invalid characters
Abbreviations
Misplaced place details

Spell Check
Spell Check is another very useful tool. I was told at one time by a schoolteacher of one of my
children that you are born a poor speller or a good speller so either way, Spell Check has you
covered. The database will identify a misspelled word with a wavy red line under the word.
When doing Spell Check there is a box that pops up and gives you suggested corrections. You
can make choices as to what you want to do with the misspelled word.

Gazetteer
The Gazetteer allows you to locate the place you are searching for on an online map. Just enter the
place name; RootsMagic searches for the place in its list of 3.5 million places and begins to auto-fill as
you type the information into the search box. You can then select the place from the list they populate
and click “Online Map…” and it will take you to the map.

Map and Information about Benton, PA
To the left of the map is a rectangular box that serves as a mini-Chamber of Commerce for the place you
have selected. If you want to remove that box, just click on the little arrow and it will collapse the box
and you can see the whole map of the area you are searching for.

Mapping
Mapping is not just another map. It allows you to find a place and provides a map for that
place. When you switch to “people” it will display all events and places from the person’s life on
the map.

This feature allows you to view the people and places in your file drawn on an interactive map. It is
built upon the Microsoft Virtual Earth platform, so Mapping requires that you be connected to the
internet (high-speed is recommended)
A list of all people or places is displayed on the left. You may switch between places or people using
the drop-down menu above the list. The actual map is displayed on the right.

Select a PLACE from the list to display that place on the map.
You can select the “Place” and zoom in or out to explore the map

Select “PEOPLE” TO VIEW EVENT MAP
If you select an individual in your database, the People View will show all the mapped events in your
database for that person – from birth to death. You can also “Include family members” which will add
more locations on the map.

County Check Explorer
County Check Explorer shows you the origin of a specific county or state and all the changes
that have occurred over time. This is helpful when researching and entering place information
into the data base. RootsMagic alerts you to the existence or non-existence of the place for a
given time period when you enter the data into your program.

CountyCheck Explorer lets you look up US, UK, Canadian and Australian counties, states, etc. to view
information about when and how they were formed, and access the FamilySearch Wiki or Newberry
Library interactive maps for places
Just type a county, state, or provide in the “Search for” field, and RootsMagic will list (in the Search
Results) the various matches it finds in the CountyCheck database. You can select any of those results
to view more detailed information about that place, including other names the place has been known
as, and what other places came from that place or contributed to that place.
You can also click the “Online Info” button to view more information about the place in the
FamilySearch Wiki, and can click the “Online Map” button to view the Newberry Library interactive
map for the place as well.

Virginia – known as:
“Known As” shows when it was created and if it has contributed to new counties or territories

Belongs to:
Belongs to shows what it originally was a part of and the time span that was involved

Contains: list of all counties
Contains will show all the counties in a specific state. Don’t forget the two buttons on the upper right of
the CountyCheck Explorer to see Online Information and an Online Map. The Online Information takes
you to FamilySearch Wiki.

More Bells and Whistles
The next 6 tools we will look at include:
Color Code People
Set Relationships
Date Calculator
Relationship Calculator
Calendar
Descendants view

Color Coding your tree
In the Pedigree View you can color code your family surnames. First, select the starting person, set the
color you wish, then choose who you wish to color code. Then click “OK”

In the Pedigree View - for Direct Lines
Set a color
Select who you wish to color code

Color Coded pedigree
When you have gone through all of your Pedigree and completed the color coding, you will see each
ancestral line reflects a different color. This is useful when you are out in the database and want to
identify your direct line in the family group.

Color coded child is the direct line
The Color Coded person is your direct line. This is especially helpful when you are out into the 4th, 5th, or
6th generation and you see consistently large families.

Set Relationships
Set Relationships allows you to put yourself (or someone else) as the Root Person and then set all
relationships in the database to that Root Person. Remember, as you build your tree, it will be
necessary to repeat this “Set Relationships” process so that the new entries will display a relationship.
This lets you set relationships for everyone in the database to a selected person.
Highlight the person you want to select. Choose “Tools, Set relationships”.
Click “Set relationships” and RootsMagic will calculate how everyone in the database is related (blood
relationships) to that person.
The status line at the bottom left of the screen will display how the highlighted person is related to
the person you set relationships for.
“Set relationships” sets the relationship for the people currently in the database. If you add
additional people you must run the command again for them to display a relationship for those
subsequently added.

Set Relationship
After the relationship is set, it will appear in the status bar at the bottom in the lower left hand corner.
As you click through names in the index, you can see that the relationship for that individual will be
displayed.

Date Calculator
The date calculator is a very handy tool. You can enter data into any two of the three fields and the
calculator will tell you what the third date is.
Enter data into any two of the three fields in the calculator and click the Calculator symbol at the right
end of the third field, and the program will calculate the third date for you.

Date Calculator
You may have information from a gravestone that shows the death date and the age of the person who
is deceased. Put that information into the date calculator (death date and age at death) and click on the
calculator and it will show you the birth date.

Entering a date in a date field
Open the Edit Person field, Select a fact with a date field. Click on the calendar icon in that field.
Calculate the date you need and then you can paste the calculated Start date or End date into the date
field for that fact.
Open the date calculator when you are on a date field in the program
Calculate the date you need
Paste the calculated starting or ending date directly into that date field
Click either “Select start” or “Select end” depending on which date you want to paste into the date
field.
Click the Clear button to clear all fields on the date calculator
Click cancel to close the calculator

Entering a date in a date field
in the program
When you want to enter a calculated date into a date field in the database, open the Edit Person screen
and go to the date field for the event you are working on. Click the calendar icon in that field. The Date
Tools “Calculator” appears. Calculate the dates and then you can choose either the “Start Date” to
insert, or the “End Date” to insert. Click on the appropriate button and it will paste the date in the date
field. I love it when that happens!

Relationship calculator
The Relationship Calculator will take any two people in your database and show you any blood
relationship between them and who the common ancestor is. Either highlight a person in your Index or
a person in the Family View and go to Tools – Relationship Calculator, or go directly to “Tools” –
“Relationship Calculator” and Select person 1 from the Index; then Select person 2 from the Index.

Select “Calculate” and Relationship appears
Once you select the two individuals click on “Calculate” and the relationship will show in the window.
There are two common relatives in this relationship.

Calendar
The next tool is the Calendar. This is a very handy tool which is also located under the Main Menu
“Tools” tab. This is a perpetual calendar. When it pops up it will show the current date. There is also a
small Calendar icon in the Date field in the Edit Person Screen.
RootsMagic provides a pop-up perpetual Gregorian calendar
*Tools, Calendar” from the main menu (pops up with the current date)
*Click on the calendar button in any date field (calendar opens displaying the date that was entered
into the field)
Click on the arrow keys to navigate from month to month or year to year.
Keep the arrow button selected to speed up in the direction as the months or years go by

Calendar in edit person screen
I use the Calendar often when reading early obituaries. If I know the date of the publication of the
obituary I can go to the calendar and bring that date up by clicking on the arrows. Then as I read the
obituary and, as an example, the date is May 28, 1908 and the obituary says the individual died on
Monday I can quickly see that the death date was May 25, 1908 and can enter “Select” and it will enter
it into the date field.

Gregorian Calendar/Julian Calendar
The Gregorian Calendar was first introduced in 1582 and it was slowly rolled out throughout the
rest of the world. The earliest adoption was in 1582 and the most recent adoption was Turkey
in 1926. It is important to be aware of the calendar and dates of change when doing early
research.
Another change that took place was the day that was recognized as the first day of the year.
th

From the 12 century until 1751 the legal year in England began on 25 March. The adoption of
1 January as the first day of the new year began as early as 1600 and slowly was accepted
throughout countries of the world.

The calendar will show dates into the BC era or centuries into the future.
HOWEVER:
Days of the week prior to Friday, October 15, 1582 will not correspond to the Julian calendar that was
in use prior to that date.
When the Gregorian Calendar was introduced, Julian (old style) date, Thursday, October 4, 1582 was
followed by Gregorian (new style) date, Friday, October 15, 1582 to compensate for inaccuracies in
the way the Julian calendar handled leap years.

Descendants View
A very useful view in RootsMagic is the use of the Descendant View. This is found by selecting
the “Descendant” tab above the Father’s name next to the Family View tab. You can view 2-7
generations in an easily read format which shows generations with children, spouses and
parents. Information includes name, gender, birth and death date and place. The columns are
resizable. This is just one of the many formats available within the program.

Shows up to 7 generations of descendants
Each generation is indented
Children will be shown below their parents
Spouses are shown with a + before their name
Shows: Name, gender, birth and death date and place
Columns are resizable
If a person in the last generation has children, an arrow will appear to the right of their name. Clicking
on this arrow will move down one generation
If a spouse (in any generation) has parents entered, an arrow will appear to the left of their name.
Clicking on this arrow will move to the parents of the spouse.
You can edit any person by double clicking their name, highlighting their name and pressing “Enter”
on the keyboard, or right click the mouse on the name and select “edit”

Descendants view
Go to the “Descendants” tab, select the number of generations of descendants you wish to
view; the wife has a red + sign; you can resize the columns. Parents of the spouse are accessed
through the red arrows on the left; you can expand the last generation to see their children by
clicking on the red arrows on the right.

Five of the 20 Available Lists
There are 20 Lists you can choose from in RootsMagic. These 5 are some of my favorites. The
first one is the To-Do-List.
To-Do-List
Address List
Correspondence List
Place List
Kinship List

TO-DO-LIST
The To-Do-List is a life saver when you are doing research. Often when I am researching I will come
across something that needs to be followed up on, but will take me away from the immediate focus. I
can open the To-Do-List and make a notation of what I need to follow up on. This keeps me from going
down a rabbit hole and losing my focus. It also eliminates the use of yellow post-it notes, yellow pads,
envelope flaps and notes on the back of scrap papers that somehow get lost or overlooked. It is just one
more example of fabulous bells and whistles built into this program!
RootsMagic lets you keep track of tasks you need to do.
It provides a to-do list for every person and family in the file, as well as a general to-do list for tasks
that don’t apply to a specific person or family

TO-DO FROM EDIT PERSON SCREEN
It can be accessed either from the “Lists” tab in the Main Menu, or from the “To-Do” tab in the “Edit
Person” screen. Click on the “To-Do” tab and it will bring up the To-Do List window. Select “Add task”
and fill in the information for that task. In the “Task” Window I typically enter the surname and given
name then in Task Details I enter my “task” (what I want to follow up on) and click “OK”.

Edit To-Do
You enter the information into the “Edit To-Do” screen. You can add an address or select a repository,
edit the screen or clear the screen. You can also transfer the “TO-DO” to your research log for that
individual. You can select a Status and a Priority for the task, as well.

To-Do Status and priority
There are 4 icons that indicate the Status of the “To-Do” Item. Open, Pending, Completed, Problem.
There are 9 levels of Priority you can select from.

To Do Master List
The Master “To-Do List” is accessible under the “Lists” tab in the main menu. This is handy when you
are reviewing any “To-Do’s” you have previously created.

Correspondence list
The Correspondence List is one of the best things invented since sliced bread! Here is one central place
you can store all your Correspondence. If you have email correspondence, it is essential to keep a good
record and the emails can be copied and pasted into your correspondence list attached to the individual
for which you have corresponded. It is an especially important when you consider any upgrade to a
computer requires migrating any important correspondence if it has not been properly “filed”. If it is
migrated to the new computer, it will not be in the original dated, recognizable format…usually there
will be numbers assigned and it requires opening each file and determining when it was written, etc.
What a fabulous tool this is.

Address list
The Address List is also a helpful tool. This list allows you to store addresses of those with whom you
have corresponded or places you have visited or need to visit for research purposes.

Place list
The Place List can be accessed from the Main Menu under “Lists” – “Place List” or you can open the
Place List by clicking the Place List button next to place fields in the Edit Person pane. RootsMagic
remembers every place that you enter into the database and as you begin to type if it begins to auto-fill.
If there are variations of the same place that have been entered into the database (different spellings or
standardized version and non-standardized version) you can merge them into the standardized format.
Highlight the one you want to keep (it will be shown in BOLD) and then check the boxes for duplicate
variants. Click “Merge Selected Places” and the merged standardized format will replace the variants
with the standardized entry throughout the database.

Completed Merge
There is only one entry for Briar Creek, Columbia, Pennsylvania, United States in the completed merge.
All prior versions of Briar Creek,
Columbia, Pennsylvania, United States
were replaced with the correct and
Standardized format

Kinship list
The Kinship List is found under “Reports”. Click on “Reports” in the Main Menu. This opens the
window entitled “Create a Report”. Either select “Lists” and scroll down to locate the “Kinship
List” or enter the name of the report in the Search Box for “Create a Report” on the right side of
the window.

Generated Kinship List
The report shows how you are related to those in your database

And even More!!! Bells and Whistles
The next set consists of the Research Manager, RootsMagic Explorer – Name Find, Sort date,
Character Map and WebSearch.
Research Manager
Roots Magic Explorer – Name Find
Sort date
Character Map – Control + T
WebSearch

Research Manager
A research log is such a great tool for keeping track of research you have done – both successful
and unsuccessful searches. The Research Log for each individual is found on the Edit Person
screen.
A research log lets you keep track of research you have done. You can create research logs for people,
families, events, or places. You can also create general research logs for other research goals as well.
You can access the Research Logs list by selecting Lists > Research Manager from the main menu, or by
clicking the Research Log button on the Edit Person screen.
When you open the list from the main menu, RootsMagic will display all the research logs for the
entire database, while opening the list from the Edit Person screen will only display research logs for
that person.

Research log from ‘edit person’ screen
Bring up the “Edit Person” screen and click on “Research Log”

From “Lists” – “Research Manager”
If you go to “Lists” from the Main Menu drop-down, you can select “Research Manager” and it will bring
up your master list of Research Logs.

Click on “Search” or the Magnifying glass
The search capabilities of RootsMagic is top-notch! Bring up RootsMagic Explorer by clicking “Search”
from the Main Menu and choosing “Person List” in the drop-down; click the magnifying glass on the
Tool Bar, select “Search” and in the drop-down select “Person List”

The RootsMagic Explorer is the heart of RootsMagic's search system.
You can bring up the RootsMagic Explorer by
- clicking the "Search" button on the menu bar
- selecting "Search, Person list" from the main menu
- clicking the magnifying glass on the tool bar
- by pressing Ctrl+F

RootsMagic Explorer - Find
Search by any information You can “Find” a person (or people) based on information other than the
name (such as birth date, death place, etc.) Click the “Find” button at the top of the Explorer window to
bring up the “Search for Information” pane. Find is one of the tools I use frequently. This tool bar allows
you to go backward and forward in your search.

RootsMagic Explorer – Name Find
If you need to find a name in your database, just enter the name – given name, nickname or surname –
and click “OK”

Perform a name find
The database is searched, name by name, looking for “Matilda”. You can continue to click “Next” until
the correct “Matilda” comes up and then press “Select”

SORT DATE
The sort date changed my life ! How many times do you enter a fact with no date or only a partial
date only to have it post out of chronological sequence? This especially happens when I am working
with death and burial, where you know the death date, but not the burial date….or multiple spouses
with missing date for one of the spouses. You know that there was a first spouse – and you know the
name but do not know the marriage date. This is where the “Sort Date” comes in handy. Using
qualifiers in the “Sort Date” field, you can enter "before" or "after" a date and it will sort it
chronologically without that “sort date” showing up under the Fact. It is just like “Magic”

Sorted in date order
Putting in the “Sort Date” makes all the difference!

Character Map
RootsMagic supports diacriticals in place fields. To bring the chart up for accessing those
diacritical marks, just press Ctrl + T when you are in a date field and it allows you to enter the
correct diacritical for the name or place. An Eszett (ß) in German, an enyay (ῆ) in Spanish or an
accent grave (é) in French….it has Arabic and Russian Cyrillic, as well
For Diacriticals and characters when entering data in data fields, use Ctrl +T

WebSearch tab
The WebSearch view tab allows you to search the Web through an online search for what ever
person you select. Click the name, select the website you want to search from the drop-down
and it will take you to the website with a specific search for the individual. Click on any name in
the Index and it will search that person, as well.
The WebSearch view makes it easy to search online for information about your family.
Switch to the WebSearch tab and RootsMagic will do an online search for the currently selected
person (if Auto-search is checked.)
If you want to find someone else just click their name in the sidebar and RootsMagic will
automatically search for them on the selected site.
Of course nobody wants to search just one site, so RootsMagic lets you select which site you want it
to use.
Click the little drop arrow to the right of the search button and choose the site you want to search.

You can use the default, Standard Search Providers in RootsMagic by selecting in the drop-down
those websites that are listed, or go to “Manage Search Providers” at the bottom of the dropdown and add your personal favorites in the list of possible searches.
Select “Manage Search Providers” in the drop-down and click on "Custom Search Providers"
To Add a New Custom Search Provider – Click the drop-down arrow and choose “Custom Search
Providers”; click “Add”. Look up the website you want to add and put the “Search Provider Name” and
then the “URL” for that website. Then click “OK”. That website will be added to your search provider
list.

Add Web Tag
When you have found a record using WebSearch, you can add a Web Tag for that document and
site. Click on “Add Web Tag” and the Name of the Person and the URL will auto-fill. Add the
name of the web page and any notes you wish to include (paste the indexed information into
the note field) and click “OK”. This web tag will then show up in the Edit Person screen for the
individual you are researching.

Click on “Web Tags” in the Edit Person Screen
In the “Edit Person” screen the WebTags tab will indicate if there is a web tag. If there is, you
can highlight the webtag you want to see and press “Go”. It will take you to the website where
the record is located (providing the link is active and not broken)

AND STILL MORE! Bells and Whistles
Can you believe there is still more? We will now look at
GeoCoding
To-Go
Key-Board Shortcuts
Comparing Two Data Bases
MyRootsMagic – Putting Your Tree on the Web
Reports
Tree Share with Ancestry (covered today - previous hour in a separate class )

GeoCoding places in your data base
GeoCoding is extremely helpful when it comes to remote areas and cemeteries. When you have the
latitude and longitude of a place you can navigate directly to it. There are 3.5 million name places in the
RootsMagic database.

RootsMagic has the ability to "GeoCode" the places in your database.
GeoCoding means to match the places in your database with a place in the 3.5 million name place
database included with RootsMagic.
When RootsMagic will go through your place list and look for a match for each place. It then adds the
standardized place name as well as the GeoCode (latitude and longitude) of the place to the place in the
database so it can be plotted on a map.

GeoCoding Mesa, Maricopa, Arizona, United States
From “Lists” go to “Place List” and select the place list. Click the “GeoCode” button and it will give the
geocode coordinates for the selected place. Double click the Place in the list and it will bring up the
“Edit Place Screen with the GeoCode if it has been entered. It also lists the Standardized Place Name.

TO-GO FEATURE
The To-Go Feature works on PCs but not on Macs. If you are using a Mac you will either need to have
a laptop to carry with you or know that the RootsMagic7 Software has been installed on the computer
you will be working on.
If your research destination has RootsMagic7 installed on the computers, you can do a back-up and
restore that serves in lieu of the To-Go feature.
Three Essential Steps in Using To-Go on a PC
* Select the Flash Drive in the drop-down window
* Install RootsMagic to the Flash Drive
* Transfer Data to the Flash Drive
The To-Go Feature works for PC’s but not yet for MACs.
If you have a MAC you can either carry your laptop with the Database installed; OR, if you know the
destination computer you will be using on your away-from-home researching has RootsMagic7 installed,
you can back up and then restore.
For the PC user, there are three ESSENTIAL steps involved in using the To-Go.
1. Select the Flash Drive in the drop-down window
2. Install RootsMagic to the flash drive
3. Transfer the data to the Flash Drive
(without these three steps, you will show up with your stick and nothing will work!)

KEYBOARD SHORTCUTS
For those who like to use keyboard shortcuts there is a great list that can be found on pages 359-361.
These shortcuts just allow you to keep your fingers on the keyboard to perform various functions. One
shortcut I use often is Shift+ Tab which will allow you to return to a previous field when you have tabbed
forward.
Shortcut keys provide quick access from the keyboard to commonly used commands.
Commands in most menus and many windows and dialogs appear with an underlined characters in
the menus or in the button.
To invoke the command, press the Alt key and the letter shown together.
Examples: Shift+Tab = back up to a previous data field
Ctrl+F = find; etc.

COMPARING TWO DATABASES SIDE BY SIDE
Comparing two databases side by side can be a real life saver when you have two sources for databases
and you want to sync them. From the “File” tab in the Main Menu, Select “Compare files…” Then click
on either “Select a file” or “Find a file”.
From the “File” tab in the Main Menu,
Select “Compare files….”

The Program Runs a Database Compare
The Database begins to collect information for comparing the two databases.

Then opens the two selected files side by side
Once it has completed its populating you will see two files, side by side. Look for the empty
spots on either file and you will be able to copy the missing data to the deficient file.

Click the name and a box pops up and you can copy it to the other file
You can copy the missing information into the other file. Comparing files will allow you to bring certain
information over but does not bring all information over. It would be necessary to drag and drop
information from one file to the other.

MyRootsMagic

MyRootsMagic is a free account for RootsMagic users which lets you publish your family tree(s) online.
This allows relatives to go online and look at and download a GEDCOM from your online tree. To begin
working with publishing, go to “Internet” from the Main Menu and in the drop-down select
“MyRootsMagic”.
MyRootsMagic is a free account for RootsMagic users which lets you publish your family tree(s)
online. To begin working with MyRootsMagic, do "Internet > MyRootsMagic" from the main menu

Sign in or create account
Click on “Sign In or Create Account” to get started. Enter your email and a password and click “Sign In”
Click the "Sign In or Create Account" button to get started. If you have not created an account yet,
click the "Create an account" link and enter your email and a desired login. RootsMagic will create the
account and then let you log in. Once you have logged in you will see a list of any trees you have
published.

My RootsMagic sign-in screen
Click the “gears” icon to access the Settings. Go through each tab and set up the parameters you want
for this website. Then Save.
To access the website, click on the magnifying glass

The Home Page
The side-bar has tabs that will take you to the various views within your website. This is the
home page.
Webpage for sharing information

Name Index
The Name Index will bring up all those in the database, listed alphabetically.

Three different views – Individual – family - pedigree
The Pedigree View brings up the pedigree and you can click on any of the three icons on the
right of each name. You have the Individual, the family and the pedigree for that individual.

Family Group Sheet
The “Family” icon brings up the Family Group Sheet and will display all the Facts in your
database for each of the individuals in the family group (spouse and children).

Pedigree Chart
Click on the “Pedigree” icon and it will put that individual in the primary position.

Caution and additional help
When creating your website title, you must be aware that it is CASE SENSITIVE and NO SPACES
BETWEEN WORDS. Try to make it short and sweet! To share this website, copy the URL and
give them your User Name and Password so they can log in.

To share with others – go to your website and copy the URL. Give them the URL. Be sure to give them
your User Name and Password so they can log in.
http://sites.rootsmagic.com/David-McHenryAncestralLines/login.php?return=%2FDavidMcHenryAncestralLines%2F
Keep the name of your website simple. It is case sensitive and should have no spaces between the
words of the website title.
If you need more help go to RootsMagicTV and watch “What’s New in RootsMagic7”. The last 30
minutes of the webinar is all about Putting Your Family Tree on the Web

Create A Report
There are 40 reports you use in RootsMagic7. One of the most amazing report is the Narrative Report.
You can generate Descendant or Ancestor Narrative Reports for a highlighted person. This is in effect, a
book format. There are multiple formats to choose from for this report.
If I do a Narrative Report looking at Everyone in my Database, in about 15 seconds, it generates the
report and gives me 2199 pages. That’s MAGIC!!!
40 Reports available to create and print

Charts (4)
Forms (4)
Labels (1)
Lists (20)
Narratives (1)
Reports (2)
Research Reports (6)
Wall Charts (2)

Tree Share for Ancestry
Tree Share with Ancestry.com was covered in the previous hour by James Tanner. For further
information, go to “Help” in the main menu and Select “Contents”. Then search for “TreeShare”
and you can learn how to use this impressive tool! There is also a 36 minute video on
RootsMagicTV for RootsMagic’s TreeShare for Ancestry. This is accessed through the Main
Menu – Help – Learning Center – RootsMagic TV
Ancestry.com is a popular subscription website for finding records with genealogical significance and
for creating and maintaining family trees.
The records found on Ancestry.com can be linked as sources to people in online member trees.
TreeShare for Ancestry enables you to download a tree from Ancestry.com into RootsMagic and
upload a tree from RootsMagic to Ancestry.com.
Images from Ancestry.com are included in the download!!!
A separate class was offered today to cover this topic!
For more information go to the main menu and select
“Help” – “Contents” – “TreeShare”

